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About Ajax AutoComplete 

How many times have you struggled with entering long lists, while you had to lookup a 

product or country? AJAX AutoComplete will make your life easier. Your users can get 

a filtered dropdown with choices after entering a few characters, enabling quick 

search and selection without having to enter long text. 

They can even autocomplete any address, city, street and country in Google Maps 

with the Google search automatically. Also you can choose to store the street, city, 

state, country and even found Geo location in separate form fields. This will save lots 

of time for your customers to complete forms with addresses, as those are now auto populated based on the 

Ajax autocomplete address lookup field!
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Features in Detail 

 

 Web standards based - AJAX AutoComplete complies with the latest web standards of the W3C. 

 

 
 

 Customization - The search box and the result list can easily be customized to fit in your site. You can 

apply any style using CSS. Choose in and outgoing transitions for your completion box such as slide, 

or fade and set its opacity.       

  

 



Ajax AutoComplete Manual 
DMXzone.com 

 

Copyright © 2011 DMXzone.com All Rights Reserved 

To get more go to DMXzone.com  

Page 4 of 38 

 Full Google Maps and Address search support - Now, you can autocomplete any address, city, street 

and country in Google Maps. 

 

 Autocomplete any address from the Google search automatically - Get suggested locations in real-

time as you type. 
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 Support for different language selection - The address fields come up in a specific language your 

choice.  

 

 Also if you choose to display the found address with DMXzone Google maps extension - the map will 

display in the selected language as well.  

  

 

http://www.dmxzone.com/go?18826
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 Store the found address in more detailed form fields automatically - Choose to store the street, city, 

state, country and even found Geo location in separate form fields. This will save lots of time for your 

customers to complete forms with addresses, as those are now auto populated based on the Ajax 

autocomplete address lookup field! 

 Place a marker for the location with DMXzone Google Maps - Display the found address on Google 

Maps together with DMXzone Google maps extension. 

 

http://www.dmxzone.com/go?18826
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 Draggable Marker - Drag the marker from the found address to a different address and 

automatically change all the other location fields. 

 

 Choose between short or long address - When splitting the found address in multiple form fields you 

can choose to either use the long text version of address component in the chosen language or the 

short version like country code. Useful when you already have a drop down with list of all countries for 

example and there you want to select the country automatically based on the Ajax AutoComplete 

address lookup field.  

 

 

http://www.dmxzone.com/go?14111&utm_source=Blog&utm_medium=link&utm_content=Ajax+AutoComplete+Gets+Supercharged+with+Address+Lookup+and+Google+Maps&utm_campaign=Ajax+AutoComplete
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 Dynamic Result Lists - Generate your search suggestions using a database. The result list loads mighty 

fast as the extension takes full advantage of the latest AJAX technologies so only the data that has to 

be displayed is loaded. 
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 Predefined lists - You don’t want to use a database? No problem, we have included a great 

collection of standard lists with useful search lists, such as countries, European capitals, states (US) 

and zip codes (US).  

 

 
 

 Generate your AutoComplete manually - If you don’t want to use a database or the predefined 

templates, you can generate your result list manually, which allows you to generate any completion 

suggestion you like. 

 

 
 

 Server Side Compatibility - The extension is fully compatible with PHP or ASP, it also supports the 

Dreamweaver Database model so you can define your connections in Dreamweaver and load it 

from there. 

 

 JavaScript Unobtrusive - Even if your users don’t use JavaScript, they can still use the entry field as 

JavaScript is only used to display the entry suggestions.  
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 Great Integration in Dreamweaver - Interactive dialog in Dreamweaver with all the options you’ll 

need. 

 

 

 An inline property inspector - The property inspector enables you to change several options after 

you’ve added the Ajax AutoComplete. 
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Before you begin 

Make sure to setup your site in Dreamweaver first before creating a page. If you don’t know how to do that 

please read this. 

Installing the extension 
Read the tutorial at http://www.dmxzone.com/go?4671  

 

Login, download the product, and look up your serial at http://www.dmxzone.com/myZone/purchases  

 

Get the latest extension manager from Adobe at  

http://www.adobe.com/exchange/em_download/ 

 

Open the .mxp file (the extension manager should start-up) and install the extension. 

 

If you experience any problems contact our Live Support! 

http://kb2.adobe.com/cps/140/tn_14028.html
http://www.dmxzone.com/go?4671
http://www.dmxzone.com/myZone/purchases
http://www.adobe.com/exchange/em_download/
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The Basics: Creating a Basic AJAX AutoComplete Field 

How to do it: 
In this tutorial we’re going to show you how easy it is to insert an AJAX AutoComplete field on to your page. 

We’ll generate the search suggestions (the fields below the entry field), using manual input, a database and 

finally we’ll use one of the supplied AutoComplete templates. 
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Generating an AutoComplete Field manually 
1. Create a new HTML page 

Create a new or open an existing HTML page and save the page.  

 

2. Applying the extension 

Choose the  icon from the DMXzone object bar to apply the extension, the following  popup 

appears: 
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3. Setting the Main Options 

The Delay determines how long it takes before your search suggestions are displayed, the higher the 

value the longer the delay, we’ll set this value to 75ms. 

 
 

When the Autoselect first suggestion option is set to true the extension will complete the word after the 

first character(s) are entered, we’ll set it to true. 

 
 

 
Autocompletion sensitivity determines how any characters must be entered before the suggestions are 

displayed; we’ll set it to 1 
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4. Configuring Effects - Completion box opacity determines the opacity of the background of the 

search suggestion box, we’ll set it to 60%. 

 
 

Show autocomplete using sets the incoming transition of the Completion box while Hide autocomplete 

using sets the outgoing transition, we set them both to fade. 

 

 
 

5. Choosing the Autocomplete data provider - We’ll select Generate autocomplete manually so we 

can make our own search suggestions, we’ll explore the other options later on. 

 

 
 

6. Configuring the Suggestions options - You can either choose Begin with or Contain user input. Begin 

with requires the word to start with the entered characters while Contain makes sure the entered 

characters are matched in the entire word, they don’t have to start with the character. We select 

the Begin with option. 
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The Maximum suggestions determines the maximum number of results, we’ll set it to five. 

 

 
The latest dropdown lets you choose whether to search for the primary (From primary) or From all fields. 

We set it to From primary fields. 

 

7. Setting the Provider properties 

Press the Add word button to add your search suggestions, we’ve added three items; 

 

 
 

Double click on the <name> or <value> field to edit the search term and the descriptive text. 
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8. You can remove items by pressing the Remove selected button. 

 

 
 

9. Final Steps 

Press OK to generate your AJAX AutoComplete field. 

 

Be sure to copy the images folder and the styles folder to your server. 

 

Press OK and press f12 to preview and save.  That’s it you’ve created your own AutoComplete field!
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 Advanced: Generating an AutoComplete Field using a Database 
 

1. First steps - Make sure you have followed steps one to four of the Generating an AutoComplete Field 

manually tutorial. 

 

2. Define a database connection - We’ll select Generate autocomplete from database so we can get 

our search suggestions from one of the supplied XML files. 

 

 
 

3. Setting the Provider properties - Setup your database connection in Dreamweaver. Please read 

“Creating a database connection” in your Dreamweaver help files if you don’t know how to do this. 

Select the database you want to use in the Connection dropdown, the Table where you want to 

retrieve your fields from and choose your search suggestions in the Autocomplete for drop down. If 

you like you can also display additional fields by choosing the Optional fields list. Hold Ctrl on your 

keyboard to select multiple fields. 

 

 
 

 
 

 

http://www.adobe.com/cfusion/livedocs/search/index.cfm?restrict=support&link=&loc=en_us&term=database+connection&go=Search
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4. Final Steps 

Press OK to generate your AJAX AutoComplete field. 

 

Be sure to copy the images folder and the styles folder to your server. 

 

Press OK and press F12 to preview and save.  That’s it you’ve created your own dynamic 

AutoComplete field! 
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Advanced: Editing the Field with the Property Inspector 

Introduction 
In this chapter we’re going to edit the properties of the AutoComplete field using the property inspector of 

Dreamweaver. Click on the preview of the AutoComplete field in the design view to display its properties. 

Below is a screenshot of the property inspector. 

 

 

The Property Inspector 

1. Setting the basic options - The Field name is used to identify the field, make sure it is unique for every 

field you use, we’ll set it to “mycountry” so we can identify it later. 

 

 
 

2. Char width sets the width of the entry field and Max chars determines the maximum number of 

characters that can be entered, we’ll set them both to twelve. 
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3. Min. chars determines the minimum number of characters that needs to be entered.  
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4. Check the Autofill option to set the AutoCompletion of words when typing in the entry field (it is the 

equivalent of the Autoselect first suggestion option in the main menu). 

 

 
 

5. The Initial value sets the default value that is entered in you field, we’ll leave it empty. 

 

 

6. Setting the Animation options  - Show sets the incoming transition and Hide sets the outgoing transition 

of the completion box. 

 

7. Delay sets the time it the time it takes before the search suggestions field is displayed, we’ll set it back 

to 100 
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8. Opacity sets the transparency of the search suggestions field. 
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9. Press the Advanced settings… button if you want to edit the main options, such as the Autocomplete 

data provider. 
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Advanced: Creating a Form with AutoComplete Fields 

Introduction 
In this chapter we’ll show you how to create a form with Autocomplete fields. We’ve created an empty 

HTML page with a background image. We are going to insert three fields, one manually, one from a 

database and one from predefined templates. The final form will look like this; 

 

 

Building the Form 
1. Create a new HTML page 

Choose File-> New in your Dreamweaver menu and select We’ve inserted a background for the 

looks, but this is not mandatory.HTML to create your page.  

2. Install the Free Submit Form extension from DMXzone.com (optional) 

The easiest way to create a submit button for your form is to install this extension which can be 

downloaded for free at DMXzone.com. Restart Dreamweaver after you’ve installed the extension. 

3. Create a form field 

The first thing we need to do is to create a form field that tells that the data in our AutoComplete 

fields must be posted. Select Insert in your Dreamweaver menu and choose the Form option and 

choose Form again.  

http://www.dmxzone.com/showDetail.asp?TypeId=3&NewsId=3982
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We’ll also specify the page that we need to go to after the form is posted. Enter thankyoupage.asp in the 

Action field of the property inspector. 
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4. Insert a table on the page - Select Insert->Table from your Dreamweaver menu and create a Table 

with two columns, four rows and no borders. 

 

 
 

Insert the text Product, Username and Country in the left columns of the table so your form looks like this; 
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5. Inserting the text and the submit button - Enter the names of our fields in the first three columns and 

insert the submit button. 

 

 
 

6. Adding The Submit Functionality To Your Button - Go to your Tag inspector and choose FlevOOware-

>Submit Form. 
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A popup appears, select your form (in this case this is the default form) and type thankyoupage.asp in the 

Form Action field (we’ll create this page later on) and press Ok. 
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Inserting the AutoComplete Fields 

1. Inserting a manual AutoCompletion field - Place the cursor into the column next to the Product and 

press the  icon from the DMXzone object bar to insert the AutoComplete field.  

 

Set the Autocomplete data provider to Generate autocomplete manually. 

 

 
 

Press the Add word button to add the search suggestions. We’ll enter the following Words and Texts; 

 

AJAX AutoComplete It’s All About Usability 

CSS Image Gallery Create Pure CSS Galleries 

Flash MP3 Player Include A Music Player On Your Site 

Flash Image Enhancer Enhance Your Images Real Time 

Fish Eye Menu Create Fantastic Fluid Menus 

 

 
 

Press Ok to include the field. 

 

2. Inserting a database AutoCompletion field - Place the cursor into the column next to the Username 

and press the  icon from the DMXzone object bar to insert the AutoComplete field.  

 

Set the Autocomplete data provider to Generate autocomplete from database. 
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We’ll use a database connection from our user database. 

 

 
 

If you don’t have a database you can create a user list manually. Press OK to insert the field. 

 

3. Inserting an Automcomplete field from predefined templates - Place the cursor into the column next 

to the Country and press the  icon from the DMXzone object bar to insert the AutoComplete field.  

 

Set the Autocomplete data provider to Generate autocomplete from predefined templates. 

 

 
4.  

Select the Countries template in the Provider properties field. 

 

 
 

Press OK to insert the field. 
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5. Enter the field names - Select the Ajax Autocomplete fields in your design view and enter the Field 

name for each field. We name the first field, product, the second username and we call the last field 

country. We use these names to display the values the user typed in the “Thank you” page that we’ll 

create later on. 
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Building the “Thank You” page 
Create a new ASP page - Choose File-> New in your Dreamweaver menu and select ASP VBScript to 

create your page. We’ve inserted a background for the looks, but this is not mandatory. We also created 

a title and typed in the text that needs to be displayed before the form results, your page should look like 

this;  

 

 
 

1. Insert the From Request Fields - We set the cursor to the place where we want to insert the form 

results and create a binding. Press the + icon in the Application/Bindings tab of your Dreamweaver 

interface and select Request Variable (select “Form variable”, if you use PHP, other properties and 

screens might differ too). 
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2. Select Request.Form in the Type dropdown fieldand enter the Name of the form field you want to 

display the results of. In this case we enter “product” as this is the first form field we want to retrieve. 

 

 
 

3. Do the same for the other fields (username, and country). You should have the following bindings; 

 

 
 

4. Now drag the fields into the correct place on your “Thank you” page to display the values the user 

entered in the form. We select the fields in our design view and make them bold (this is optional), you 

should see the following in your design view: 

 

 
That’s it, you’ve created your own form that allows users to enter values that are displayed on your “Thank 

you” page. Save your page, open the form and test in your browser to see how it works. 
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Reference: Advanced Customization 

Introduction 
In this chapter we are going to show you the layout and design flexibility our extension offers. By editing the 

autocomplete.css file you can set a huge range of options. We’ll discuss the most important ones.  

 

You can open the CSS file in Dreamweaver by double clicking on it in the CSS panel: 

 

 
 

Changing the Completion Box Properties 

This table explains how to change the colors and borders of your completion box. 

 

Item to change 
Relevant CSS 

rule 

Property and value to add 

or change 

Background color 

.ac_results 

 

background-color 

Border Thickness and Color 

border 

 

 

 

The color of highlighted characters of the completion 

box that match with the entry field 
.ac_highlight color 

Background color of the selected item in the 

completion box 
.ac_over background-color 
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Setting Margins and Paddings 
 

This box explains how you change margins and padding of your completion box items. 

 

Item to change 
Relevant CSS 

rule 

Property and value to add or 

change 

Padding around the results 
.ac_results 

 
padding 

The margin around the individual list items .ac_results li margin 

The margin around the list items as a group .ac_results ul margin 

The left padding around the individual list 

items 
.ac_results li padding 

The left padding on the list items as a group .ac_results ul padding 

 

Setting the Font Properties 
 

This box explains how you change the font and its properties. 

 

Item to change Relevant CSS rule Property and value to add or change 

Font of the completion list items 
.ac_results li 

 
font 

Font size of the completion list items 
.ac_results li 

 
font-size 
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FAQ 
 

Q: My AutoComplete does not work  

A: Make sure you have uploaded all the files and folders to your server and that JavaScript is enabled in your 

browser. 

 

Make sure you’ve uploaded the following files in your ScriptLibrary folder: 

 autocomplete.css 

 jquery-latest.pack.js 

 jquery.autocomplete.js 

 jquery.bgiframe.min.js 

 jquery.dimensions.pack.js 

 

Also, do not forget to upload the files that list the text autocomplete in their filenames (their names are 

generated dynamically so they may differ from yours) such as: 

autocomplete-pagename-xxx-1.txt 

autocomplete-tpl-pagename-xxx-Countries -1.txt 

autocomplete-pagename-xxx-1.asp 

autocomplete-pagename-xxx-1.php 

 

Q:  Can I use a database to provide the AutoComplete information? 

A:  Yes, the extension will detect all the connections defined on your site and provides the opportunity to 

select a particular table and various fields for its auto-complete information.  

 

Note:  This feature only works for sites that use PHP or ASP VBScript. 

 

Q:  Which server-side technologies are supported? 

A:  The extension could be used with all server-side technologies supported by Dreamweaver.  But the 

database interface integration can only be used with PHP or ASP VBScript. 
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Video: Adding a City Search Field with Auto Completion 

  

 

 With this movie we will show you how easy it is to insert a city search field that uses Ajax 

AutoComplete on your page. 

 

 

Video: Working with Ajax Autocomplete Store ID Field Feature 

 

 

With this movie we will show you how to select an ID field for the autocomplete field to 

store it in a specific hidden field using Ajax AutoComplete. 

 

 

Video: Using Google Search Option in Ajax AutoComplete 

 

With this movie we will show you how to use the autocomplete from Google search option 

in Ajax AutoComplete. 

 

 

Video: Connecting Ajax AutoComplete and DMXzone 

Google Maps 

 

With this movie we will show you how to connect the Google search autocomplete option 

in Ajax AutoComplete with DMXzone Google Maps in order to autofill Address Form fields 

on your page. 

 

 

 

http://www.dmxzone.com/go?14111
http://www.dmxzone.com/go?14111
http://www.dmxzone.com/go?18868
http://www.dmxzone.com/go?18869
http://www.dmxzone.com/go?18826

